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This document contains information about Fiery EX2101 Printer Controller for 
Xerox 2101

 

™

 

 software version 2.2. This document supplements your Fiery EX2101 
Printer Controller for Xerox 2101 user documentation and describes additional features not 
covered in the user documentation. Before using the Fiery EX2101 Printer Controller with 
version 2.2, make a copy of these 

 

Customer Release Notes 

 

and distribute them to all users.

This document uses the term “Fiery EX2101 Printer Controller” to refer to the 
Fiery EX2101 Printer Controller for Xerox 2101.

The version 2.2 system software must be installed on the Fiery EX2101 Printer Controller 
before you can use the full functionality of version 2.2.

To print to the Fiery EX2101 Printer Controller, you must install the printer driver on each 
client computer. Make sure you delete the existing Fiery EX2101 Printer Controller printer 
driver before you install the new one. On Windows computers, use the Fiery Printer Delete 
Utility to delete a printer driver. The 

 

User Software Installation Guide

 

 describes how to use 
the Fiery Printer Delete Utility and how to install printer drivers on all supported operating 
systems.

Fiery EX2101 Printer Controller for Xerox 2101 software version 2.2 includes these new 
features:

• An increase in the maximum number of copies you can print to 9999.

• Options for printing booklets with covers. See “Booklet cover options” in the next 
section.

• Improved IOT Interrupt button functionality. See “Using the IOT Interrupt button” on 
page 4.

• Safe Erase for deleting files from the server. See “Enabling Safe Erase” on page 4.

• Printing to a custom page size from an internal tray (Tray 2, Tray 3, or Tray 4). Enabling 
this feature on your Xerox 2101 copier requires a Xerox technician. Contact your Xerox 
representative for more information.

• Fiery Job Monitor no longer starts automatically on Windows startup. See “Starting Job 
Monitor” on page 5 if you want to run Job Monitor.

 

Booklet cover options

 

When you print a booklet, you can add a cover to it. You can specify whether the front and 
back covers are blank or printed and what paper source, media type, and media color to use.

The booklet cover options have the following requirements and restrictions:

• The booklet cover options are available in the PostScript printer drivers for 
Windows 98/Me, Windows NT 4.0, Windows 2000 (Service Pack 2), and Windows XP 
(Service Pack 1).

• The booklet cover options are not available for the Mac OS drivers or the Windows PCL 
driver.

New features

Booklet cover
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• You cannot set any booklet cover options through Command WorkStation

 

®

 

 overrides. If 
you have the optional Fiery Advanced Controller Interface (FACI) connected to the 
Fiery EX2101 Printer Controller, you cannot use Command WorkStation overrides on 
the FACI to set any booklet cover options.

• Printing booklets from the following applications is supported:

Microsoft Word, Excel, and PowerPoint from Microsoft Office 2000/XP

Adobe Acrobat 5.0.x and 6.0 (Standard and Professional)

Adobe Acrobat Reader 6.0 

When printing from Adobe Acrobat 6.0 (both Standard and Professional) and Adobe 
Acrobat Reader 6.0, you must select either Send at Start or Send for Each Page under 
Advanced Print Setup to print the job as a booklet. Otherwise, the job may print with 
unpredictable results. 

 

T

 

O

 

 

 

PRINT

 

 

 

A

 

 

 

DOCUMENT

 

 

 

AS

 

 

 

A

 

 

 

BOOKLET

 

 

 

WITH

 

 

 

A

 

 

 

COVER

 

1. Choose Print in your application.

2. Choose the Fiery EX2101 Printer Controller as your printer and click Properties.

3. Click the Fiery Printing tab.

4. Click the Paper Source print option bar and set the Page Size option to 8.5x11-SEF, A4-SEF, 
11x17, A3, 8.5x14, 8.5x13, B4, or SRA3.

N

 

OTE

 

:

 

If you print from Microsoft Word, you must also select the same page size in the 
Page Setup dialog box.

 

5. Click the Finishing print option bar and set the Folding option to Half-Fold (inside).

6. Click the Layout print option bar and set the Booklet Maker option to Standard Booklet.

 

The Xerox 2101 copier must have the Booklet Tray option installed, and the printer driver 
must be configured with the Booklet Tray option installed.

 

7. Set the Booklet Cover Mode option.

Off:

 

 Prints a booklet with no cover.

 

Blank

 

 or 

 

Printed:

 

 Prints a booklet with a cover as specified by the Booklet Front Cover 
Mode and Booklet Back Cover Mode options.

 

N

 

OTE

 

:

 

If you select Blank, use the default settings for the Booklet Front Cover Mode and 
Booklet Back Cover Mode options (see the next two steps). Do not set Booklet Front Cover 
Mode or Booklet Back Cover Mode to Blank. If you do, an extra blank page may be 
inserted after the cover page.

 

8. Set the Booklet Front Cover Mode option.

Print On Front Only:

 

 Prints the first page of the document on the front of the front cover. 
The second page of the document is the first page of the booklet’s content.

 

Print On Back Only: 

 

Prints the first page of the document on the back of the front cover. 
The second page of the document is the first page of the booklet’s content.

 

Print Both:

 

 Prints the first and second pages of the document on the front and back of the 
front cover. The third page of the document is the first page of the booklet’s content.

 

Blank:

 

 Leaves the front cover blank on both sides. The first page of the document is the first 
page of the booklet’s content.
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9. Set the Booklet Back Cover Mode option.

AutoSelect:

 

 Does not force any back cover mode. The front cover is printed according to 
Booklet Front Cover Mode, and the remaining pages of the document are printed in order 
after that, with no blank pages in between. Depending on where the last pages of the 
document fall, the back cover may be printed on both sides, printed on the front side only, 
or blank.

 

Print On Front Only:

 

 Prints the last page of the document on the front of the back cover.

 

Print On Back Only: 

 

Prints the last page of the document on the back of the back cover.

 

Print Both:

 

 Prints the last two pages of the document on the front and back of the back 
cover. 

 

Blank:

 

 Leaves the back cover blank on both sides. 

For all Booklet Back Cover Mode settings except for AutoSelect, blank pages may be 
inserted at the end of the booklet’s content, depending on the number of pages in the 
document. For example, if Booklet Back Cover Mode is set to Print Both, blank pages are 
inserted before the last two pages of the document as needed to make the last two pages fall 
on the back cover.

 

10. Set the Booklet Cover Source option.

 

Choose Auto Select to use any tray that matches the Booklet Cover Media and Booklet 
Cover Media Color settings (see the following steps). 

 

N

 

OTE

 

:

 

If you also set the Paper Source option (which specifies the paper source for the 
booklet’s contents) to Auto Select, the booklet cover and its contents are printed from the 
same tray. Make sure that either Booklet Cover Source or Paper Source is set to a specific 
tray.

For a blank cover, choose Tray 2, Tray 3, Tray 4, or Tray 7.

For a printed cover, choose Tray 2, Tray 3, or Tray 4.

 

11. Set the Booklet Cover Media option.

 

Choose Normal or Heavyweight1A for Tray 2, Tray 3, or Tray 4.

Choose Heavyweight1B or Heavyweight2 for Tray 7.

 

N

 

OTE

 

:

 

If you select a weight other than Normal, be sure that you program a tray to that 
weight at the copier before submitting the job to print. 

 

12. Set the Booklet Cover Media Color option.

 

Choose White, Green, Blue, Yellow, Buff, Goldenrod, Other 1 or Other 2.

 

N

 

OTE

 

:

 

If you select a color other than White, be sure that you program a tray to that color 
at the copier before submitting the job to print. 

 

13. Set any other options necessary to print the booklet.

14. Click OK to close the Properties window, and then click OK to submit the job for printing.
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Using the IOT Interrupt button

 

Pressing the IOT Interrupt button suspends a print job in progress (after the copier has 
finished printing its current set of pages) and allows you to use the copier to make copies 
manually. After a period of time, the print job resumes. You can program the time period at 
the copier. The default time period is 15 seconds. 

There is no indication on the Fiery EX2101 Printer Controller that the print job has been 
interrupted. The status of the job remains Printing.

 

N

 

OTE

 

:

 

You are allowed to specify finishing options, such as stapling, for the copy job, even 
if the print job you interrupt also has finishing options.

Use the IOT Interrupt button with caution. If you encounter an error while you are 
copying (such as a paper jam or an out-of-paper condition), the print job cannot be 
resumed and you must resubmit it. When you resubmit the job, reduce the number of sets 
desired by the number already printed.

 

N

 

OTE

 

:

 

If you interrupt a job that has finishing options, such as stapling or folding, and an 
error (such as a paper jam or an out-of-paper condition) occurs on the copier before it 
finishes printing its current set of pages, the interrupt light stays on and the copier stops 
responding. You must restart the copier. When you resubmit the job, reduce the number of 
sets desired by the number already printed.

 

Enabling Safe Erase

 

Safe Erase renders files deleted from the Fiery EX2101 Printer Controller permanently 
inaccessible. Normally, files that have been deleted from the Fiery EX2101 Printer 
Controller can still be recovered. If you enable the Safe Erase option, deleted files are 
overwritten to prevent file recovery. 

 

T

 

O

 

 

 

ENABLE

 

 S

 

AFE

 

 E

 

RASE

 

1. With the Fiery EX2101 Printer Controller idle, press the Menu button on the Control Panel.

 

The Functions menu appears.

 

2. Select Run Setup, and enter the password if prompted.

3. Select Server Setup. 

4. Scroll through the options to the Enable Safe Erase option, and select Yes. 

5. Scroll through the options to the Save Changes option, and select Yes.

 

If you print a Configuration page, Safe Erase is shown as enabled.

For information about accessing Fiery EX2101 Printer Controller Setup from the Control 
Panel, see the 

 

Configuration Guide

 

.

IOT Interrupt 
button

Safe Erase
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Starting Job Monitor

 

Job Monitor no longer starts automatically on Windows startup. Use the following 
procedure to start Job Monitor manually.

 

T

 

O

 

 

 

MANUALLY

 

 

 

START

 

 J

 

OB

 

 M

 

ONITOR

 

1. Windows 98/Me/NT 4.0/2000: Click Start, choose Settings, and then choose Printers. 
Windows XP/Server 2003: Click Start and choose Printers and Faxes.

2. Right-click the Fiery EX2101 Printer Controller icon, and then choose Properties. 

3. Click the Printer Status tab, and then click the Launch Job Monitor button.

 

You can also double-click the Job Monitor shortcut on the desktop to start the utility.

Job Monitor opens a utility window on the screen and establishes a connection to the 
Fiery EX2101 Printer Controller. If you have installed and configured printer drivers for 
more than one Fiery EX2101 Printer Controller, Job Monitor automatically establishes 
connections to all.

After you start the utility, an icon for Job Monitor appears in the Windows taskbar.

 

T

 

O

 

 

 

EXIT

 

 J

 

OB

 

 M

 

ONITOR

 

1. Right-click the Job Monitor icon in the Windows taskbar. 

2. Choose Exit Job Monitor. 

 

The Job Monitor window closes, and the icon for Job Monitor is removed from the 
Windows taskbar.

To enable Job Monitor to start automatically each time you start your Windows computer, 
see the following procedure.

 

T

 

O

 

 

 

ENABLE

 

 J

 

OB

 

 M

 

ONITOR

 

 

 

AT

 

 W

 

INDOWS

 

 

 

STARTUP

 

1. Right-click the Job Monitor icon in the Windows taskbar. 

2. Choose Preferences. 

3. Select Run at Windows startup in the dialog box that appears. 

4. Click OK to save your preference settings. 

 

For more information about Job Monitor, see Job Monitor Help.

Job Monitor
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Defects fixed in this version

 

The following defects are fixed with this version.

 

Previous fixes included in this version

 

This version incorporates the following previously released patches. There is no need to 
install these patches separately:

• 1-CUN89 fixes a banner/cover page defect

• 1-DLITA fixes loss-of-communication defects

• 1-CBF01 fixes booklet printing defects

• 1-DEUM4 fixes a PCL text box image defect

• 1-DU8WY supports booklet covers and fixes a number of defects

• 1-CZYMX updates LILO to the latest version, but the LILO version is not printed on 
the Configuration page.

 

Description of fix SPAR number

 

If you suspend and then resume printing a multiple-copy job with finishing 
(such as stapling) specified, the copies printed after the job is resumed have 
the correct finishing.

540736061

When you select Suspend Printing, the current job pauses printing at the 
next logical break (such as the end of the next set).

877282872

When you print multiple, collated copies of a multiple-page document using 
the Mixed Media feature, the output pages are ordered correctly for all 
copies.

684751350

The Fiery EX2101 Printer Controller status is updated correctly in 
Command WorkStation.

701476091

An 8.5

 

x

 

11 document printed as a booklet on 11

 

x

 

17 size paper prints 
correctly. See “Printing a booklet on 11

 

x

 

17 or A3 size paper” on page 12.
702630753

In jobs of 100 copies or more, the Fiery EX2101 Printer Controller and the 
Xerox 2101 copier remain synchronized and communicate the same status.

909861809

If you print a multiple-copy job with stapling and the paper runs out while 
the job is printing, the stapling is performed correctly for the copies printed 
after you add paper.

942538626

A PCL duplex printing job no longer prints with long edge binding 
(top-bottom) instead of short edge binding (top-top).

212657902
179939951

If the Fiery EX2101 Printer Controller stops responding after being sent a 
large number of jobs, you can cancel or suspend jobs.

462377235

The Fiery EX2101 Printer Controller no longer stops printing with an 
incorrect message indicating that Tray 6 is out of paper.

612730971
766159199

When you change PCL font settings, the font settings will change and print 
correctly.

281232155

When you download a PCL font, the PCL job will print correctly. 467698493

Fixed defects
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Additions to the user documentation

 

The following sections contain additions or changes to the Fiery EX2101 Printer 
Controller user documentation.

 

SMNP Community Names

 

If you receive the following dialog box when you launch WebSetup, install Sun Java on your 
computer.

 

Sun Java

 

Use Sun Java instead of Microsoft Java. Fiery WebTools

 

™

 

 performs at its best when using 
Sun Java. To download Sun Java, use the link provided in Fiery WebTools.

 

T

 

O

 

 

 

DOWNLOAD

 

 S

 

UN

 

 J

 

AVA

 

1. Start your Internet browser.

2. Enter the IP address or the DNS name of the Fiery EX2101 Printer Controller.

3. Click Installer.

4. Under Windows, click Sun JRE.

 

The File Download dialog box appears.

 

5. Select if you want to run the program from the location or save it to disk.

6. Click OK.

 

If you receive a Microsoft Internet Explorer security warning for Sun Java installation, click 
OK and continue with the install.

 

Configuring servers in Fiery WebTools

 

If the copier is off and you access WebSetup, the SNMP Community Names window 
appears. Exit out of this window and turn on the copier.

If you are using MicroSoft Java instead of Sun Java, and you access WebSetup with invalid 
Internet Explorer security settings, instead of the Accessing WebSetup instructions, the 
SNMP Community Names window appears. To avoid this, use the following procedure to 
modify the Internet Explorer security settings.

Additions to 
documentation

Setup
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T

 

O

 

 

 

MODIFY

 

 

 

THE

 

 I

 

NTERNET

 

 E

 

XPLORER

 

 S

 

ECURITY

 

 

 

SETTINGS

 

 

 

FOR

 

 
I

 

NTERNET 

 

E

 

XPLORER

 

 4.

 

X

 

1. From the Internet Explorer menu choose Internet Options.

2. Click the Security tab.

3. With Internet zone selected in the Zones box, click Custom (for expert users).

4. Click Settings and scroll to Java.

5. Under Java Permissions, choose Custom and click Java Custom Settings.

6. Click the Edit Permissions tab.

7. Under Unsigned Content:Run Unsigned Content, choose Run in Sandbox.

 

This security option runs WebSetup and other applets while keeping your local system 
secure. It also enables communication via SNMP.

 

8. Click OK and then click OK again.

9. In the Internet Options dialog box, click Apply.

10. Restart your browser for the new settings to take effect.

 

T

 

O

 

 

 

MODIFY THE INTERNET EXPLORER SECURITY SETTINGS FOR 
INTERNET EXPLORER 5.X

1. From the Internet Explorer menu choose Tools>Internet Options.

2. Click the Security tab.

3. Select Internet in the zone box and click Custom Level.

4. Under Java Permissions choose Custom and click Custom Java Settings.

5. Click the Edit Permissions tab.

6. Under Unsigned Content:Run Unsigned Content, choose Run in Sandbox.

This security option runs WebSetup and other applets while keeping your local system 
secure. 

7. Under Additional Unsigned Permissions:Access to all Network Addresses, choose Enable.

This setting enables communication via SNMP.

8. Click OK twice to return to the Security tab.

9. Select Local intranet and click Custom Level.

10. Repeat steps 4–8.

11. Click OK (several times) to return to Internet Explorer.

12. Restart your browser for the new settings to take effect.

When you open WebSetup to configure a server in WebTools, the SNMP Community 
Names window is displayed. Use the following procedure to enter SNMP community 
names correctly.
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TO ENTER SNMP COMMUNITY NAMES

1. In the SNMP Community Names window, enter names for Read Community and Write 
Community, and click OK.

2. If you enter names that are invalid, the Accessing WebSetup window appears.

Do not modify Internet Explorer security settings as indicated in the online instructions. 
Instead, click OK to close the Accessing WebSetup window. Then enter valid names in the 
SNMP Community Names window, and click OK. You can download the updates onto 
your computer and then to the Fiery EX2101 Printer Controller using Command 
WorkStation or Fiery Downloader.

Bindery Setup

In the list of available servers in Bindery Setup, the scroll bar on the right side has an up 
arrow but no down arrow.

Non-localized Strings

In Dutch, two messages are not translated in the SNMP Community Names login window.

Printer Status: Trays

The Printer Status tab does not display the paper levels of Tray 5 and Tray 7 when paper is 
loaded in those trays.

Problem Feeding Paper from Tray 7 with Mixed Media

Depending on the marketplace, Tray 7 is set up either for 8.5x11 SEF (in the US) or A4 
SEF (in Europe). If your copier is set up the opposite way, an error message appears in the 
Mixed Media dialog box, and the job does not print.

Scale to Fit and Image Shift

If you print a document with size specified and the print options Scale to Fit and Image 
Shift on, the image appears truncated.

Error Messages Truncated

Command WorkStation, Fiery EX2101 Printer Controller control panel, and Fiery Bar 
error messages may appear truncated.

Powering on/off the Fiery EX2101 Printer Controller

Occasionally, when you power off and then power on the Fiery EX2101 Printer Controller, 
the network connection settings may be lost. To avoid this, when you turn the power switch 
off, you must wait at least 10 seconds before turning the power switch back on. 

System
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Preview FreeForm Master

Preview does not show the latest FreeForm™ master if it is larger than 64KB. 

When you preview the FreeForm master, the image is slightly blurry because of the 
limitations of black-and-white systems.

PostScript Printer Driver only for Booklet Maker, Folder, Mixed Media

You must use the PostScript driver, rather than the PCL driver, for booklets, folders, and 
folding options. However, the PCL driver does include punch options.

The PCL driver allows you to select center staple although this is not an option since 
booklets are not supported with this driver.

Mixed Media is not supported for PCL.

The PostScript driver online help files do not cover Mixed Media. For further information, 
refer to the Printing Guide.

Sheet Sets in Booklet Maker

For booklets, the number of sheets folded as one set is set at the Xerox 2101 copier. 
Changing this setting on your copier requires a Xerox technician. Contact your Xerox 
representative for more information.

Copier Icon for Booklet Maker

The copier icon that appears when Booklet Maker is selected does not match the actual 
copier options that you have.

Booklet Maker and Paper Sizes

When you select Booklet Maker, the driver prompts you to load 8.5x11-SEF. However, in 
spite of this message, you can either load the desired, supported paper; or, before selecting 
Booklet Maker, select the desired paper size if you do not want 8.5x11-SEF. Supported 
paper sizes for Booklet Maker are 8.5x11-SEF, 11x17 or Tabloid, A4-SEF and A3, 8.5x14 
or Legal, 8.5x13, and B4.

For booklets in Microsoft Word, you must select short-edge feed paper. In Microsoft Word 
Page Setup, set up Letter as 8.5x11-SEF.

Finishing Legal Mixed with Letter

To finish Legal (8.5x14) paper mixed with Letter paper, select short-edge feed for Letter, 
which is 8.5x11-SEF. For Microsoft Word, you must set this in Page Setup.

Face-up Stapling

With face-up stapling, the staples are on the wrong side of the paper. To work around this, 
print face-down.

Perfect Binding

Perfect binding prints pages in backwards order. To work around this, set Page Order to 
Reverse.

Printer driver
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Imposition and Center Staple

From DocBuilder Pro Imposition and Booklet Maker, an imposed document with a center 
staple folds in the wrong direction. To fold and staple the job correctly, set the following 
options in the order specified:

1. Page Order = Reverse

2. Folding = Half-Fold (outside)

3. Stapler Mode = Center

4. Duplex = Top-Top

Booklet Maker with Center Staple

Do not select reverse page order when you have selected Booklet Maker>Standard Booklet 
and center staple.

Staple and Punch

Staple and punch are not supported on Index2, Heavyweight2, labels, and transparencies.

Duplex Top-Bottom with Dual Staple

It is possible to select duplex top-bottom with dual staple; however, doing so might produce 
undesired results.

Missing Paper Sizes in Mac OS X

Some paper sizes are missing from the Mac OS X driver: A4 P is displayed as A4 A4, 
8.5x14 is missing (use Legal instead), JB4 should be B4, JB5 should be B5 P, where P 
stands for the long edge of the paper.

Document Default Page Size on Mac OS X

The document default page size on Mac OS X does not change from letter to A4 when you 
change regional settings. To work around this, set the page size in the Print Center 
Preferences window. To do this, open the Print Center, select Print Center>Preferences 
from the menu bar, and select the desired default page size to be used for all documents.

Constraints Not Enforced in Mac OS X

In Mac OS X, you are allowed to choose illegal combinations, which may produce 
unpredictable results. Later releases of Mac OS X may fix this problem.

Tri-Z or Tri-C

Do not print a duplex job with the Negative option and tri-folding. This may cause the 
paper to jam.

When you are setting up a job for Tri-C or Tri-Z fold (8.5x11 or A4) or Z-fold (A3 and 
11x17), select the SEF orientation in the Fiery Driver page size menu. Selecting LEF results 
in a conflict.

Wrong Default Paper Size on Mac OS 9

The default page size for Mac OS 9 is letter instead of A4.

A6 Paper

A6 paper is not supported for the Fiery EX2101 Printer Controller.
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Two-Way Communication

When you select Two-Way Communication and enter the Printer IP Address or DNS 
name, the Update button may be unavailable. If the Update button is unavailable, wait 
until the Fiery EX2101 Printer Controller receives the server information. The Update 
button will be connected.

Tray 6 and Tray 7

When you disconnect Tray 6 from the print engine or if Tray 6 is not installed, Tray 7 does 
not display in the Printer Status tab even if Tray 7 is installed. Although you may not see 
Tray 7 in the Printer Status tab, the tray works properly.

Decimal Separators

In the Fiery EX2101 Printer Controller printer driver or in Fiery Setup, you may see 
decimal separators instead of commas in some European languages.

Mixed paper sizes

When you print a mixed paper size job with different orientations, for example one group 
of pages is Portrait and the other group is Landscape, your job may not print properly. You 
may see that the job will print with the first orientation specified. If this happens, use the 
Mixed Media option. This allows you to specify the orientation and finishing of each page 
range.

Booklet jobs

If you print a booklet job with the Negative setting, random pages may print with a 
different imageable area.

Z-fold 

You can use the Mixed Media option to specify a Z-fold page within a booklet job when the 
body of the booklet is printed on a page size that is not supported with Z-fold. Z-fold 
supports A3, B4, 11x17 and 8K page sizes. No constraints appear when you select a page 
size that is not supported with Z-fold. Pages on unsupported sizes are printed but not 
folded. 

Printing a booklet on 11x17 or A3 size paper
The following procedure explains how to set the correct print option settings for printing 
an 8.5x11 document as a booklet on 11x17 paper, or for printing an A4 document as a 
booklet on A3 paper.

TO PRINT AN 8.5X11 (A4) DOCUMENT AS A BOOKLET ON 11X17 (A3) SIZE PAPER

1. Open the document in its application.

2. Select File>Page Setup.

3. Set the Paper Size to 8.5x11-SEF (A4-SEF).

NOTE: This step may not be necessary for PDF documents.

4. Select File>Print, choose the Fiery EX2101 Printer Controller as your printer, and then 
click Properties. 

Printing
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5. In the Fiery Printing tab, open the Paper Source bar and choose the following settings:

Page Size: 8.5x11-SEF (A4-SEF)

Print Size: 11x17 (A3)

Scale to Fit: On 

6. In the Fiery Printing tab, open the Layout bar and choose the following settings:

Orientation: Choose Portrait for vertical spine or Landscape for horizontal spine.

Booklet Maker: Standard Booklet

Imposition Reduction: Clear this option.

NOTE: When you set Booklet Maker, a conflict message appears regarding Half-Fold 
(inside). To resolve the conflict, click OK.

7. For a stapled booklet, open the Finishing bar and set Stapler Mode to Center.

8. Click OK to close the Properties window.

9. Set the number of copies. 

10. Click OK to submit the job for printing.

Perfect Booklet Imposition

Booklets are folded backwards, but if you select reverse-order printing, they are folded 
properly.

Punch options

If a Punch unit is installed on the Xerox 2101 copier, you can specify punched output. You 
must select a setting for both the Punch Edge and Punch Holes options. If either option is 
set to None, no holes are punched.

NOTE: Some combinations of page size and punch edge are not allowed by the copier even 
though you can specify the combination when you print. Jobs with invalid combinations of 
page size and punch edge are printed but not punched. For more information, see the 
copier documentation.

Stapler Mode option

Use the Dual (Left or Top) setting of the Stapler Mode option to finish a job with two 
staples. A portrait-oriented job is stapled on the left edge, and a landscape-oriented job is 
stapled on the top edge. 

NOTE: The icons in the printer driver do not show the correct staple positions for a 
landscape-oriented job.

Tab printing (EFI Hot Folders/Tab Wizard option)

A tab cannot be the first sheet of a document. The workaround is: 

1. Set and create the tabs through the Tab Wizard.

2. Process and Hold the job.

3. Select Preview.

4. Under the Preview window, drag the tab to be the first page and then print.

To use the Tab Wizard, you must install Adobe Acrobat, which is provided with the EFI 
Hot Folders/Tab Wizard option.

Print options

Tab Printing
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Displaying Job Attributes

For any additional job attributes that are not displayed in Command WorkStation, you can 
add those fields or attributes by right-clicking the Command WorkStation status bar and 
selecting the attribute from the pull-down menu. After you do this, those additional 
attributes appear in the jobs that have them.

Unsupported file formats

Unsupported file formats (.jpeg, .gif, .html) appear in the file format list in 
WebDownloader. Do not download these file formats using WebDownloader. Although 
the Fiery EX2101 Printer Controller does not support these files directly, you can open the 
file in the application in which it was created and then print the file.

VPS and PPML

Contrary to statements in the user documentation, VPS and PPML are not supported.

Microsoft PowerPoint

The background does not print in PowerPoint. To work around this, select Color in the 
Microsoft portion of the printer driver.

Mixed Paper Sizes in Microsoft Word Duplex
For a duplex Microsoft Word job, if the job contains 8.5x11-LEF and 11x17 duplex, the 
11x17 sheets must be separated in one of two ways:

• Using Microsoft Word, insert an 8.5x11-LEF sheet in between the 11x17 sheets. 

• Using Mixed Media, for simplex 11x17, set the pages to duplex off.
For duplex 11x17, set the pages to duplex Top-Top.

If the job contains 8.5x11-LEF and 11x17 and is not a duplex job, you can use hole 
punch, staple, and Z-fold without making any additional changes.

Adobe Acrobat 5.0 booklet

If you select the Negative option and select settings other than the default settings for 
Booklet Front Cover Mode or Booklet Back Cover Mode, unexpected results may occur 
when printing an Acrobat 5.0 booklet job. For example, the next page of the cover may 
print white. To avoid this, if you print a booklet job with the Negative option using Acrobat 
5.0, make sure that the booklet cover modes are set to the default settings.

Adobe Acrobat 5.0 stapled jobs

When you print a stapled job using the Windows 98 Postscript printer driver, the job may 
not staple in the location specified. For example, if you print an 8.5x11 LEF job and specify 
Upper Left for Staple Mode, the job is stapled upper right. If you print an 8.5x11 LEF job 
and specify Upper Right for Staple Mode, the job is stapled lower right. If this happens, use 
the PCL driver or use SEF.

Adobe Acrobat 5.0 and 6.0 PCL duplex jobs

Duplex jobs do not print properly when you print them from the PCL printer driver. For 
example, if you print an 8.5x11 SEF job and specify Top-Top for Duplex, the job is printed 
Top-Bottom. If you print an 8.5x11 SEF job and specify Top-Bottom for Duplex, the job is 
printed Top-Top. If this happens, use the PostScript driver or use LEF.
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